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Agenda

► Introduction
► Baseline
► Drivers of Change
► Gaps
► Options
► Next steps
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Baseline
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Baseline
Current and planned electrification (S)
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Baseline
Current and planned electrification (N)
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Baseline
International comparisons
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Drivers of change



/19-Jan-15 8

Drivers of Change
Passenger diesel services

► Improving affordability and value for money by:
• Reducing rolling stock operating costs
• Improving rolling stock reliability

► Enhancing capacity and connectivity by:
• Reducing journey times
• Providing more capacity for unelectrified routes
• Improving network availability

► Reducing environmental impacts through:
• Lower emissions
• Reduced noise
• Compliance with environmental policy legislation

► Alternative approaches deliver benefits with lower costs
• Low cost electrification using conventional electric rolling stock
• Discrete / discontinuous OHL with onboard independent traction
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Drivers of Change
Freight diesel services

► Enhancing capacity and connectivity by:
• Allowing greater trailing weights with less speed penalty and shorter 

journey times
• Releasing capacity for other services

► Improving affordability and value for money by:
• Reduced locomotive requirement arising from journey time savings
• Shorter routings
• Reducing FOC operating costs

► Subject to the following enabling factors:
• New electric locomotives
• Investment in terminals to accept electrically hauled longer intermodal 

trains
• Investment in new electrification infrastructure, including power supply 

strengthening on existing electrified routes
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Drivers of Change
Existing DC routes

► Enhancing workforce and public safety
► Improving affordability and value for money by:

• Reducing infrastructure maintenance and renewals costs
• Reducing infrastructure operating costs
• Reducing losses of power in transmission
• Enhancing infrastructure reliability and resilience

► Enhancing capacity and connectivity by:
• Increasing infrastructure capacity through higher levels of installed 

traction power
• Reducing journey times through better acceleration

► Subject to costs of:
• Infrastructure conversion
• Rolling stock conversion
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Drivers of Change
Existing AC routes

► Further electrification is likely to increase the usage of the existing 
electrified network in terms of:

• Additional rolling stock movements on the existing network
• The usage of existing National Grid supply points to provide power for 

newly electrified routes
► Additional services may require an upgrade to the existing supply in order 

to support both current and future demand 
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Gaps
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Gaps
Gap types

► Gaps between the baseline and a future network which could exploit the 
benefits of modern AC electrification can be identified in 3 key areas:

• Unelectrified sections of the network
• Sections of the network equipped with third rail DC electrification which 

could be converted to AC overhead
• Sections of the network already equipped with overhead AC 

electrification for which renewal or enhancement might be justified
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Options
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Options
Matrix of gaps and options

Option →

Voltage AC OHL AC OHL DC third rail AC OHL AC OHL DC third rail Unelectrified

Continuity Continuous Continuous Continuous Discrete Discrete Discrete -

Contact 
system / 
clearances

GB Master 
Series

Lower 
specification Conventional GB Master 

Series
Lower 

specification Conventional -

Rolling stock AC AC DC IPEMU IPEMU IPEMU IPEMU

Gap Unelectrified       

↓ Existing DC      - -

Existing AC  - - - - - -
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Options
Drivers and assessment criteria
Strategic goal Supported by selecting options 

which ensure
Assessed by

Improving affordability 
and value for money 

Maximum value for money for 
passenger and freight operators 

A Passenger and freight 
‘Conversion ratio’

More efficient deployment of 
diesel traction 

B Reduction in diesel passenger 
traffic on the existing electrified 
network 

C Passenger diesel island fleets 
targeted 

Enhancing capacity and 
connectivity 

Exploitation of synergies with 
passenger rolling stock 
procurement 

D Diesel passenger vehicles 
released for cascade to 
unelectrified routes, adjusted for 
age

Improved network availability E Passenger diversionary route 
capability 

Reducing environmental 
impacts

Impacts not route-specific 
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Options
The initial sift

► Key measure of likely business case is traffic converted to length of 
route electrified (the ‘conversion ratio’)

► For each remaining diesel passenger service and intermodal freight 
flow (following completion of committed projects) calculate the 
length of electrification required for it to convert to electric

► Look at where service groups overlap and combine options where 
the conversion ratio can be improved (with a limit on option size)

► Consider requirements for diversionary routes, and add these to the 
most appropriate options

► Order the options by their conversion ratio, and consider how the 
case for each would be affected by the earlier higher-priority 
schemes
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Options
Results of initial sift (S)
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Options
Results of initial sift (N)
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Options
Selecting options for appraisal
► Results of initial sift grouped into tiers, where 1 = highest conversion ratio and 6 

= lowest
► Results for remaining measures are grouped into six categories and allocated 

star ratings
► 5 stars indicates a result in the top 1/6 for that measure
► The following mixed traffic routes have been selected for socio-economic 

appraisal (business case):
• Options with a conversion ratio in Tiers 1 and 2
• Options with a Tier 3 conversion ratio which score highly against at least 

one the other factors

19-Jan-15
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Options
Components of electrification costs
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Options
CP5 projects vs. RUS estimates

CP5 electrification projects Signalling 
immunisation

11%

Power distribution
13%

OHL
43%

Structures, fencing 
and vegetation 

clearance
33%

RUS electrification estimates Signalling 
immunisation

13%

Power distribution
7%

OHL
36%

Structures, fencing 
and vegetation 

clearance
44%
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Options
Impacts reflected in business case appraisal

Cost estimates produced on the basis of engineering assessments 
and standard unit rates

Principal benefits comprise:
► Reduction in operational costs
► Benefits related to improved journey times & journey opportunities
► Reduced greenhouse gas emissions
Quantify vs. capture
► Some benefits captured quantitatively in economic appraisal (e.g. 

opex, greenhouse gases)
► Others dealt with qualitatively (e.g. improved station & on-board 

environment for passengers)
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Options
Key appraisal assumptions
► The socio-economic appraisals reflect funders’ guidelines and key assumptions 

have been discussed with DfT.  However, some key points to note include:

• In general, the scheme AFCs include a 50% allowance for risk/contingency 
on top of the point estimate.  As these schemes are at a pre-GRIP level of 
development, the capital cost for appraisal purposes includes 66% 
optimism bias on top of the point estimate (in line with funder’s appraisal 
guidelines, WebTAG)

• The appraisals generally reflect the anticipated pattern of services at the 
end of CP5 (for example, post-Northern Hub service patterns in the north 
of England).  The significant exception to this is HS2, the impact of which is 
not reflected in any of the appraisals. HS2 could reduce the value of some 
proposed electric services by providing direct on-rail competition

• Freight benefits are only monetised in the F2N business case

19-Jan-15
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Options
Appraisal results with +/- 20% capital cost range

- 0.5 1.0 1.5 2.0 2.5 3.0 3.5

Northallerton and Ferryhill to Middlesbrough
Cross Country Core (Bristol / Leamington to Derby)

Hull to Church Fenton and Doncaster via Selby
Birmingham Snow Hill Lines (after Chiltern Main Line)

Chiltern Main Line (after Cross Country Core)
Midlands to Anglia (F2N)

Wolverhampton to Shrewsbury
Stockton to Sunderland (after Northallerton to M'boro)

North Downs Line
Westbury to Redbridge and Eastleigh (after Berks & Hants)

West of England Main Line
Hurst Green to Uckfield

Calder Valley East
Calder Valley West (after Calder Valley East)

Severn Tunnel Junction to Gloucester (after Cross Country)
Worcester to Hereford (after Birmingham Snow Hill)

North Wales Coast Line
Matlock Branch

Buxton Line (after CLC and Hope Valley)
CLC and Hope Valley

Harrogate Line

BCR / VfM
Low High →Medium← Poor

775 STK

113 STK

306 STK

71 STK

154 STK

423 STK

137 STK

11 STK

291 STK
153 STK

97 STK

60 STK

132 STK

96 STK

111 STK

190 STK
202 STK

241 STK
55 STK

98 STK

514 STK
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Options: 
F2N option: benefits

► Freight capacity benefits: equivalent to extra 6 paths per day.  Based on 
20% increase in capacity because of train lengthening due to more 
powerful new AC traction. However only on fully electrified routes which 
are c. 60% of all flows:

►Diesel only F2N (48tpd CP5 Package 1) = 50% increase in 
Felixstowe capacity

►F2N OLE = an additional 12% (20% of 60% of flows) increase in 
Felixstowe capacity relative to the 48tpd

► Freight carbon benefits due to transfer from diesel to electric 
traction: based on estimates of gross tonne kms switched from diesel rail 
traction to electric rail traction. 

► Benefits to passenger services: benefits to passenger services using 
the F2N route (same methodology as for passenger options). 

Freight benefits account for about 70% of total benefits; passenger 
benefits for 30%.  
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Options
F2N option: business case summary

Excluded from business case – cost of new 
electric locomotives needed for growth in 
traffic and for existing diesel services

514 single track km to be wired between 
West Midlands and Felixstowe (excludes 
CP5 HLOS electrification)

Excluded from business case – cost of 
possible power supply enhancement on 
existing routes

Excluded from business case – cost 
for existing terminals and the Port of 
Felixstowe to be adapted for electric 
locos (electric or bi-mode) and/or longer 
trains (775m)

Key
Existing OLE
HLOS CP5 OLE
F2N OLE (CP6 and Beyond)

BCR with capex +20%:1.2
BCR with central capex: 1.5
BCR with capex-20%: 2.1.

Felixstowe to Whitacre Junction electrification
Includes passenger electrification benefits and builds on F2N 48tpd capacity
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Options
Key points re. F2N option 
Option was appraised relative to a Base Case – Do Minimum of Package 1.  
This package was based on Package 1 in the June 2014 F2N strategic 
business case. 

•Appraisal does not include costs of electrification at Port of Felixstowe or at 
any other terminals (as required to enable “end to end” electrification on 
otherwise fully electrified routes).

•Assumed F2N electrification follows Birmingham-Derby

•Appraisal does not include FOC rolling stock costs or operating cost savings. 

•Cost currently at GRIP 0. GRIP 1 cost to be confirmed Spring 2015
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Options
Hierarchy of AC electric traction options

Presentation Title: Insert > Header & Footer

Option 
Hierarchy

Option Advantages Disadvantages Applicability

1 Diesel or DC 
to 25 kV AC 
OLE

Greatest flexibility and 
operating benefits 
supporting all types of 
electric rolling stock 
including high speed 
passenger and freight 

Fixed cost of 
infrastructure of 
installation of OLE

► Starting for any scheme considering introducing 
AC electric traction

► It is the only option when considering 
o high speed passenger, and/or 
o freight electric traction.

2 Diesel or DC 
to reduced 
clearances, 
neutral 
sections 
and/or trolley 
wire contact 
systems

Potentially lower fixed 
costs of OLE 
infrastructure 

Reduced flexibility, may 
need bespoke rolling 
stock, only lower speeds 
or locations where 
extended neutral 
sections are 
operationally feasible, 
and no freight benefit

Where the business case threshold is not met  for 
25 kV AC conventional OLE, reduced clearance or 
lower cost contact systems could be considered on 
routes:
►Passenger services less than 100mph
►No planned  AC electric traction.

3 Diesel or DC 
to on board 
independent 
power

Reduces the need to 
provide new 
electrification 
infrastructure

Higher cost rolling stock 
with on board 
independent power,  not 
suited for high speed 
passenger or mainline 
freight, re-charging time 
penalty and bespoke 
rolling stock

Where the business case threshold is not met  for 
25 kV AC conventional OLE,  on routes less than 
100mph independently powered trains could be 
consider where:
►Where gaps are within the capability of current 
energy storage
►Where it is possible to reduce the extent of OLE 
using energy storage.
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Options
Independently Powered EMU 
Trial Specification

Presentation Title: Insert > Header & Footer

19-Jan-15

Target Areas

Range

Acceleration, Speed

Operational cycles

Life Time

Safety

50km, Regional Service

Similar to DMU

30km battery – 50km overhead

5 to 7 Years life

High level of Intrinsic Safety
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IPEMU Performance Status 

Objective Target Objective IPEMU current status
Safety High level of Intrinsic with 

secondary safety control
Safety Case approval for 
passenger service.
High level of Intrinsic chemical 
stability with secondary safety 
software control.

Speed DMU operating speed (60mph) E* design limit (100mph+)

Extreme Range 40 miles 30 miles (full performance)
48 miles (typical branch line)*

Operating Cycle (Branch) 70% (OLE) to 30% (battery) 60% (OLE) to 40% (Battery)
on  HAR-MAN diagram – 22 
miles for a round trip. One trip 
uses ~25% state of charge

Battery Life 5 – 7 years 5 years (predicted)

Passenger impression No noticeable difference No difference reported

*Extreme range – Testing to‐date has shown a total 48 miles (typical branch line duty) were covered before the batteries isolated due to 
low state of charge.

The diagram being used for passenger service is part of the Abellio Greater Anglia 
network and is a branch railway line from Manningtree to Harwich Town. 
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Options
IPEMU driver’s experience



/19-Jan-15 33

Options
IPEMU next steps

 Industry workshop day at the end of January – share the learning from the 
trial and seek input into next steps

 Evaluation of trial data and modelling and business cases of candidate routes 
(main output of the trial is a validated modelling tool based on the trial data):

• Unelectrified routes without committed plans for full electrification
• Routes operated by diesel services at speeds under 100mph:

- Unelectrified branch line – charging points are at one or both ends of 
the line

- The service operates on an electrified main line but begins or ends 
its journey on an unelectrified branch line

- The service travels over a long distance and potentially bridges
several gaps in electrification infrastructure

- Groups of services radiating from a central electrified station or core 
network to serve a number of unelectrified branch lines.

 Potential to assess the amount of infrastructure that can be removed from the 
scope of works of an electrification scheme given the capability demonstrated 
by the trial

19-Jan-15
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Options
Conversion of existing DC routes

► Costs and benefits of conversion of 3rd rail DC to AC overhead has been 
previously assessed for:

• The route from Southampton to Basingstoke
• The entire third rail DC network in southern England 

► Conversion of a large proportion of the network is required to achieve 
‘value for money’

► Improvement if providing for other capacity or renewals benefits
► An update of the costs and benefits will be undertaken
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Options
DC-AC conversion principles

To be considered on a case by case basis where a business case 
exists

Route that maximise benefits – cost savings, journey time savings 
and freight opportunity

Capacity benefits – an efficient alternative to other capacity 
requirements

Appropriateness – interface with other AC routes, fewer structures, 
existing dual voltage stock

Timing – Consistency with renewals dates for rolling stock, DC 
infrastructure, linked to other electrification schemes
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Options
Existing AC routes
Renewal of replacement of existing OHL could be considered in one of the 
following two instances:

► Where usage of an existing AC electrified section is expected to increase 
significantly following extension of the electrified network to cover 
additional routes

► Where the impact on performance arising from degraded or unsuitable 
OHL is sufficient to warrant consideration of the case for renewal or 
replacement
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Next steps


